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Copyright and Terms of Use 
Please leave all references to “FridgeMonsters” intact in the documentation and code 
examples.  
 

1. Except as otherwise provided, the contents of these notes shall not be reproduced, 
republished, uploaded, posted, transmitted or distributed electronically or non-
electronically in any way, without FridgeMonsters LLP prior written permission. 
 
2. Modification of any of the contents or use of the contents for any other purpose will be 
a violation of FridgeMonsters LLP copyright and other intellectual property rights. Graphics 
and images in these notes are protected by copyright and may not be reproduced or 
appropriated in any manner without written permission of FridgeMonsters LLP. 
 
3. FridgeMonsters LLP reserves all rights to deny or restrict access to these notes to any 
particular person or persons, or to block access from a particular Internet address to the 
FridgeMonsters.com Web Site, at any time, without ascribing any reasons whatsoever. 
 

4. These Terms of Use shall be governed and construed in accordance with laws of the 
Republic of Singapore. 
 
For full details, please view the Terms of Use document at :  
http://www.FridgeMonsters.com/administration/terms.asp 
 
5. Please report any errors in this tutorial to errata@FridgeMonsters.com 
 
Annotation 
Shortcut keys are indicated by [].   

eg  
Move Tool = [w] 
Rotate Tool = [e] 
Duplicate = [Ctrl]+[d] 
Parent = [p] 
Middle Mouse Button = [MMB] 
Right Mouse Button = [RMB] 

 

http://www.fridgemonsters.com/administration/terms.asp
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Introduction 
This tutorial covers an in-depth practical approach to developing a completely automated 
gear system. The tutorial will show you how to do everything from modelling gears that 
successfully interlock, to coding (MELScript) the system.  

 
Learning Outcome 
The objective of this tutorial is to introduce you to the following :  
 

 Getting Started and Creating the first Cog 
i. Scene setup and Timeline 
ii. Modelling a Cog 

 Creating the Prototype Cogs 
i. Creating a set of cogs that interlock 
ii. Customising the cogs 
iii. Creating your first Gear Combination 
iv. Revision 

 Creating the Gear System 

 Creating the Door 
i. Calculate the Size of the Teeth.  

 Animating the Gears 
i. Creating the MELScript  
ii. Creating an Expression 

 The Expression Editor 
 Error Checking 

iii. Finishing Touches 
 Anticipation & Overlap (roll back and forward) 

iv. All Stop..!!  …Weight 
 Door Driven 

i. The Door as the Driver 
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Setting the Project 
The Project folder contains all the source files used in the scene, which are organised into 
sub-folders. This allows your scene to source for all the appropriate files and references in 
an organised manner. 

 
Create a New Project… 
 

File > Project > New 
1. Name the Project 
2. Location to Save the Project 
3. Set Folder Names 

 
Name the Project : only use lower case characters, obvious names with no spaces. 
Location of Project : The default location is set to Documents Folder, but if you are not 
working on your own computer it’s better to save it to the Desktop. You can copy the 
Project folder to your portable device when you have finished this tutorial. 
 

Do not save your project to your portable drive (thumb drive) at this stage or the 
performance will lag. 
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Name your project : gears. Click the Use Defaults button to set the Project Data 
Locations. Then click Accept. 
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Getting Started and Creating the first Cog 
Set the Timeline to 500 frames. 
 

 
 

Create a Polygon Cylinder. 
 Polygons > Create > Polygon Primitives > Cylinder 

 

 
 

Select the Cylinder and modify values by opening the Channel Box. In the Shape Node, 
set the values too…     
 

Radius 10 
Height 5 
Subdivision Axis 20 

 

 
 

Note : Make sure the Cylinder is positioned at the Origin (0,0,0). 
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Creating the Cog Teeth. 
There are 20 faces around the circumference of the cylinder. In Component mode, select 
10 alternate faces and Extrude them to create the Teeth. 

 
Polygons > Edit Mesh > Extrude 

 

 
 
Extrude the selected Faces 4 units in the Z axis. 

 

 
 
Scale the teeth 0.8 units in the Local Scale X & Y axis… 
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Rotate the Cog 90° on the Z Axis to stand it up.  Delete History and Reset 
Transformation. 
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The first Cog is complete..!!   
 
 
Note : It is important to remember this Cog has 20 segments (10 teeth) and a radius 
of 10 units. It is important to remember that all future Cogs will be multiples of these 

numbers. 
 
This means a Cog twice the size will have 40 segments, a radius of 20 units and 20 teeth. 
A Cog half the size will have 10 segments, a radius of 5 units and 5 teeth.  
 
If you follow this simple rule, the gears will easily fit together and it will be easier to 

calculate the rotation values.  
 
Now you understand how a Cog is created, delete the first Cog and we’ll start again..  
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Creating the Prototype Cogs 
Now that you know how to create a basic Cog, create 4 new Cogs (small, medium, large 
and extra large). These Cogs will form the basis of your Gear system by matching them 
together in different combinations. 

 

 
 

Check they have the correct Radius and Subdivision values, and then rename them. 
 

 

 Small Medium Large X-Large 

Radius 5 10 15 20 

Subdivisions 10 20 30 40 

Rename cog10 cog20 cog30 cog40 

 
Select and Extrude the alternate faces around the Circumference to create the teeth.  
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Rotate the 4 Cogs 90° in the Z Axis to stand them up.  Delete History and Reset 
Transformation. 

 

 
 

You now have your 4 basic prototype Cogs, ready to create the Gear System. All the other 
cogs in the system will be Duplicates of these 4 prototypes. 

 
Creating your first Gear Combination 
The next objective is to create a Gear Combination. This requires 2 different sized Cogs 
connected to a Spindle (Cylinder), as indicated in the diagram below. 
 

 
 

The example above combines cog10 (10 teeth) with cog30 (30 teeth). 
 
Duplicate cog10 and cog30, Ctrl + [d]. Then align them using the Move Tool [w] with 
Point Snap [v] pressed. 
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Before we proceed with the tutorial, this is a convenient time to consider the size of the Cogs 
and relationship between them. Look at the diagram above…. 
 
The radius of cog30 (large) is 3 times bigger than cog10(small). Likewise, the number of 
teeth on cog30 is 3 times as many of cog10.  
 
The most important value for us in this tutorial is this Circumference - The Circumference of 
cog30 is 3 times the length of cog10. This means that if both cogs rotate 360° over the same 
time period, the teeth on cog30 will have covered 3 times the distance as the teeth on 
cog10..    …and therefore the teeth on cog30 are moving 3 times faster than cog10. 
 

Note : cog30 is 3 times faster than cog10 is the same as cog10 is 3 times slower than 
cog30. 
 

 
 
In the image above cog10 and cog30 are both rotated 90° over 25 frames – both are rotating 
at the same speed. However, the distance covered by the teeth on cog30 is clearly further 
than the teeth on cog10. Therefore the teeth on cog30 are moving 3 times faster than the 
teeth cog10.  
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Customising the Cogs 
As the objective of this tutorial is Rigging, the Modelling aspect is kept to a minimum – The 
cogs are very simple. However, to make things more visually interesting in this tutorial, it’s a 
good idea to customise the cogs as you create the Gear system. 

 
In Component mode [RMB], select the Vertices of each cog and Move [w] them to 
customise the thickness of each cog. 

 

 
 

 
Note : Remember to return to Object Mode. 
 
Create a Polygon Cylinder for the connecting spindle.  

 

 
 

Don’t forget to Delete History and Freeze Transformations after you have positioned and 
resized the spindle (Cylinder). 
 
Rename the spindle Cylinder gear01. 
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Select cog30 and cog10 and Parent [p] to gear01. 
 

 
 

 
 

The first Gear is complete..!!   
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Revision 
Before you start creating the other Gears, it is a good idea to revise the relationship between 
the cogs. Here are the 4 prototype cogs you created earlier. 
 

 
cog10 cog20 cog30 cog40 

 
The image below contains 3 simple Gear setups. Consider the following very carefully.. 

 
[a] cog40 is rotating 4 times slower than cog10 
[a] cog10 is rotating 4 times faster than cog40 
 
[b] cog10 is rotating 3 times faster than cog30 
[b] cog30 is rotating 3 times slower than cog10 
 
[c] cog20 is rotating 2 times faster than cog40 
[c] cog40 is rotating 2 times slower than cog20  
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Creating the Gear System 
Following the method outlined on page 10 -13, create the remaining 4 gears ([B] – [E]), 
and rename them gear02 to gear05. The aim is to rotate gear01 [A], which will cause  
the door [F] to move up and down. 

 
Move [w] the gears into a suitable starting position, so that the cogs interlock with each 
other. You’ll also need to individually rotate [e] cogs to achieve this. Do not rotate the 
spindle/parent objects (gear01 – gear05), only the cogs. 
 

 
 
Note : Take note that gear05 [E] only has 1 cog..   …cog30. 

 
Creating the Door 
I added the door to this tutorial because up to this point it is all pretty easy. So, the aim 
of the door is to complicate matters slightly and challenge you. 
 
The reason the door is slightly complicated is because it needs teeth to interlock with 

cogs. The problem is you don’t know the actual size of the teeth… yet.   
 
Start by making a Polygon Cube. 
 
 Polygons > Create Polygon Primitives > Cube 
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Calculate the Size of the Teeth.  
If we take cog20 as an example, it is a Cylinder with a radius of 10 units and 20 teeth 
(Subdivisions). 

 
We can discover the size of the teeth by calculating the circumference of cog20 and 
dividing it by 20. 
 

 
 
The circumference of a circle is calculated as : 2∏ * radius 
Where ∏ (Pi)=3.14159 
 

..therefore, circumference of cog20 is… 
 

 =2∏ * radius 
=(2*3.14159)*10 
=62.831 
 

..therefore, the size of the teeth is 62.831/20=3.14155 units each. 

 
 

A door with 10 teeth (Subdivisions) would be 31.1415 units in height.  
A door with 50 teeth (Subdivisions) would be 157.077 units in height.  
 
And, a door with 20 teeth (Subdivisions) would be 62.831 units in height. 
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Select pCube1 and modify values by opening the Channel Box. In the Shape Node, set 
the values too…     
     

Width 10 
Height 62.831 
Depth 40 
Subdivision Axis 20 

 
Select the alternate Faces. Extrude and scale them as indicated below. 
      

 
Delete History and Reset Transformation. Rename pCube1 as door.
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The Gear system should now be setup as indicated in the diagram below, containing 5 
gears ([A] – [E]) and a door. The aim is to rotate gear01 [A] and cause door [F] to 
translate (move) up and down.  
 

 
 
You’re now ready to start animating. 
 
Animating the Gears 
The objective of this tutorial is to create a simple Gear system that is simple to animate 
and easily modified. It would be far too tedious and time consuming to Keyframe the 
rotation of gear01- gear05 + TranslateY of door. It would be even more tedious to modify 

it several times if your Supervisor required it.  
 
For that reason, we’ll create a system that only requires the animator (you) to animate 
gear01.  
 
Select gear01 and create the following 2 Keyframes… 

 

 

 
Play the animation and check that gear01 rotates 10 times.  
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Creating the MELScript  
MELScript is the programming language used in MAYA. An Expression is a MELScript that 
runs every frame and allows you to create animation. 
 

The next step is to write a MELScript that calculates the rotation value for each gear 
(gear[2] – gear[5]). We’ll start by creating and explaining the MELScript first, and then 
show you how to use the Expression editor later in the tutorial.  …So, theory and code 
first. 
 

MELScript for gear02 

In the diagram below, cog10 is paired to cog20. When cog10 is rotated, cog20 will rotate 
at 1/2 the speed.  
 
This can be summarised as a ratio - cog10/cog20=0.5 (10/20=0.5). The MELScript to 
rotate gear02 by 1/2 the rotation value of gear01, in the opposite direction is.. 
 

gear02.rotateX=gear01.rotateX*-0.5; 

 

 
 

MELScript for gear03 
In the diagram below, cog10 is paired to cog40. When cog10 is rotated, cog40 will rotate 
at 1/4 the speed.  
 
This can be summarised as a ratio - cog10/cog40=0.25 (10/40=0.25). The MELScript to 

rotate gear03 by 1/4 the rotation value of gear02, in the opposite direction is.. 
 

gear03.rotateX=gear02.rotateX*-0.25; 

 

 



www.FridgeMonsters.com Page 21 Chris Shaw 

MELScript for gear04 
In the diagram below, cog20 is paired to cog30. When cog20 is rotated, cog30 will rotate 
at 2/3 the speed.  
 

This can be summarised as a ratio – cog20/cog30=0.66 (20/30=0.66). The MELScript to 
rotate gear04 by 2/3 the rotation value of gear03, in the opposite direction is.. 
 

gear04.rotateX=gear03.rotateX*-0.66; 

 

 
 

MELScript for gear05 
In the diagram below, cog10 is paired to cog30. When cog10 is rotated, cog30 will rotate 
at 1/3 the speed.  
 
This can be summarised as a ratio – cog10/cog30=0.33 (10/30=0.33). The MELScript to 
rotate gear05 by 1/3 the rotation value of gear04, in the opposite direction is.. 
 

gear05.rotateX=gear04.rotateX*-0.33; 

 

 
 

 
 
..Phew..!!   Here’s the MELScript so far.  
 

gear02.rotateX=gear01.rotateX*-0.5; 

gear03.rotateX=gear02.rotateX*-0.25; 

gear04.rotateX=gear03.rotateX*-0.66; 

gear05.rotateX=gear04.rotateX*-0.33; 
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Finally, the difficult part – gear05 lifting the door. 
 
gear05 contains a single cog30. For each degree cog30 rotates the door will translate in 
the Y axis. If we calculate the circumference of cog30 and divide by 360°, we’ll know how 

much to Translate the door in the Y axis. 
 

Wait, wait..!! That was explanation was too fast..!! OK, here it is again..   
 

1. Rotating cog30 360° will translate door the same distance as the circumference of 
cog30.  

2. Therefore, we can assume that by rotating cog30 1°, door will translate 
circumference/360. 

      

 
      

The circumference of a circle is calculated as : 2∏ * radius 
Where ∏ (Pi)=3.14159 
 

..therefore, the circumference of cog30 is… 

 
 =2∏ * radius 

=(2*3.14159)*15 
= 94.248 

 
 ..therefore, rotating gear05 by 1° will translate door.. 
 

=94.248/360° 
=0.2618 
 

..therefore, rotating gear05 by 90° will translate door.. 
 

=90*0.2618 

 
The MELScript to translateY door, based on the rotation of gear05 is.. 
 

door.translateY=gear05.rotateX*0.2618; 
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So, the completed MELScript is… 
 

gear02.rotateX=gear01.rotateX*-0.5; 

gear03.rotateX=gear02.rotateX*-0.25; 

gear04.rotateX=gear03.rotateX*-0.66; 

gear05.rotateX=gear04.rotateX*-0.33; 

door.translateY=gear05.rotateX*0.2618; 

 

 

 
Creating an Expression 
Now that we’ve written the MELScript, the next step is to use it to create an Expression. 
Open the Expression Editor. 
            

 Window > Animation Editors > Expression Editor 
             

 
Enter the name gearRotation into the Expression Name field. 
 
Type the MELScript code into the Expression: field. Click Create to Compile and Save the 
Expression.  
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If you have followed the tutorial correctly, you have finished. Play the animation and the 
gears should all by rotating and synced together.   
 
Error Checking 
However, if you have made a typo in the MELScript and it produces an Error or incorrect 
results you’ll need to edit the Expression. Open the Expression Editor.    
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List the Expressions. 
 
 Select Filter > By Expression Name 
 

Then select gearRotation in the Selection listing. 
 

 
  

 
Finishing Touches 

Up to now, the animation in this tutorial is very simple – gear01 rotates 10 times (3600°) 
over 20 seconds (500 frames). 
 
Add some Anticipation to the start and Overlap to the end of the rotation for gear01. 
 

Frame 1 :  Start Position : 0° 
Frame 25 : Roll backwards to anticipate : -90° 
Frame 450 : End of 10 rotations : 3600° 
Frame 500 : Roll backwards to rest position : 3560° 
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All Stop..!! 
To help create the illusion of weight in the way the gears rotate, they should come to a 
complete start and stop at each key frame.. Select gear_basic01, and in the Channel 
Box select RotateX. Open the Graph Editor  
 

Window > Animation Editors > Graph Editor 
 
 

Select all 4 Keyframe markers (small black dots) and set the Tangents to Flat Tangent. 
This will ensure the animation comes to a compete start and stop at each keyframe – 
indicating weight. 
 

 
 

Play the Animation.  
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Door Driven 
In the previous section of this tutorial, the gear01 was the driving force for the animation. 
In the next section the project is reversed to make the door the driving force.  
 

gear_basic05.rotateX= door.translateY/0.2618; 

gear_basic04.rotateX= gear_basic05.rotateX*-3; 

gear_basic03.rotateX= gear_basic04.rotateX*-1.5; 

gear_basic02.rotateX= gear_basic03.rotateX*-4; 

gear_basic01.rotateX= gear_basic02.rotateX*-2; 

 
 

 
As explained on page 22, when gear05 or driving the door the translation of the door is 
calculated as:  
 

 door.translateY=gear05.rotateX*0.2618; 

 
In the diagram above the driver is reversed from [gear05 > door], to [door > gear05]. 

Therefore, the rotation of gear05 is calculated as  door.translateY/0.2618; 

 
The MELScript to rotate gear05 is.. 
 

gear_basic05.rotateX= door.translateY/0.2618; 

 
 

 
In the diagram above, cog30 is paired to cog10. When cog30 is rotated, cog10 will 
rotate at 3 times the speed.  
 
This can be summarised as a ratio – cog30/cog10=3 (30/10=3). The MELScript to rotate 
gear04 by 3 times the rotation value of gear05, in the opposite direction is.. 
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gear_basic04.rotateX= gear_basic05.rotateX*-3; 

 

 

 
In the diagram above, cog30 is paired to cog20. When cog30 is rotated, cog20 will 

rotate at 1.5 times the speed.  
 
This can be summarised as a ratio – cog30/cog20=1.5 (30/20=1.5). The MELScript to 
rotate gear03 by 1.5 times the rotation value of gear04, in the opposite direction is.. 

 

gear_basic03.rotateX= gear_basic04.rotateX*-1.5; 

 

 

 

 
In the diagram above, cog40 is paired to cog10. When cog40 is rotated, cog10 will 
rotate at 4 times the speed.  
 
This can be summarised as a ratio – cog40/cog10=4 (40/10=4). The MELScript to rotate 
gear02 by 4 times the rotation value of gear03, in the opposite direction is.. 
 

gear_basic02.rotateX= gear_basic03.rotateX*-4; 
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In the diagram above, cog20 is paired to cog10. When cog20 is rotated, cog10 will 
rotate at 2 times the speed.  

 
This can be summarised as a ratio – cog20/cog10=2 (20/10=2). The MELScript to rotate 
gear01 by 2 times the rotation value of gear02, in the opposite direction is.. 
 

gear_basic01.rotateX= gear_basic02.rotateX*-2; 

 

 

 

Good luck and enjoy. 
 

 


